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Abstract 

 

 

UWB System (3.1 to 10.6 GHz) has become a highly competitive topic in both academy and 

industry communities of telecommunication. To minimize the potential interferences between 

the UWB System and the narrowband System, a compact CPW-fed planer UWB antenna with 

dual bands at WLAN/WiMAX frequencies is to design and analysed. 

The dual Band-notched operations are achieved by etching two nested C-shaped slots in the 

rectangular metal radiating patch. It is found that by adjusting the total length of the C-shaped 

slot to be approximately half-wavelength of the desired notched frequency, a destructive 

interference can take place, causing the antenna nonresponsive at that frequency. It is easy to 

tune the notch centre frequency with the change in total length of the C-shaped slot. 

Single slot is to be etched for single band rejection by etching two nested C shaped slots in the 

patch dual band-rejection filtering properties in the WLAN/WiMAX bands (3.5 to 5.5 GHz) can 

be achieved. This antenna is to be simulated using EM software is expected to give wide 

impedance bandwidth, stable radiation pattern and constant gain.   
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CHAPTER ONE 

 
INTRODUCTION 

 

 
1.1 OBJECTIVE AND GOAL  

 
The objective of the project is to design and fabricate an antenna that transmits or receives 

UWB signals. An antenna is a transducer between a guided wave propagating in a transmission 

line, and an electromagnetic wave propagating in an unbounded medium, like air. All wireless 

systems have a transmitting antenna and a receiving antenna. The transmitting antenna is the 

antenna that obtains the signal from the source. The receiving antenna is the antenna that 

outputs the desired signal to a receiver. Antennas are used for many applications; one of the 

more recognizable applications is radio. The receiving antenna on a car collects the signal from 

the radio station and outputs the signal into the receiver. Music can now be heard in the car. 

Over the designated bandwidth of UWB system (3.1-10.6 GHz), there are some other existing 

narrowband services that already occupy frequencies in the UWB band, such as wireless local-

area network (WLAN) IEEE802.11a operating in the 5–6 GHz band. Besides the WLAN, in 

some Europe and Asian countries, WiMAX service from 3.3 to 3.6 GHz also operates in the 

UWB band.  

So the main goal of the project is to design an antenna that is used for UWB applications with 

dual notched frequency bands both in 3.3–3.6 GHz and 5–6 GHz to minimize the potential 

interferences between UWB system and narrowband systems. 

 

1.2 MOTIVATION FOR THE USE OF ULTRA-WIDEBAND 

 

As a consequence of increasing demand the issue of rational use sharing and protection of the 

radio spectrum is becoming very important. So consequence of the limited radio spectrum is 

the development of new technologies to increase the efficient use. Ultra Wide Band (UWB) 

systems having wide bandwidth with low power spectral density and it is true that this 

increases efficiently the utilization of the radio frequencies. UWB technology is based on the 

use of very narrow baseband pulses in the order of nanoseconds. These pulses result in spectral 

components covering a very wide bandwidth in the frequency domain. The impulsive nature of 

UWB emissions and the resultant spectral characteristics have caused concerns about the 

compatibility of these signals with existing radio systems. 

For communication applications high data rates are possible due to the large number of pulses 

that can be created in short time duration. Due to its low power spectral density, UWB can be 
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used in military applications that require low probability of detection. Other common uses of 

UWB are in radar and imaging technologies, where the ability to resolve multipath delay is in 

the nanosecond range, allowing for finer resolution whether it be from a target or from an 

image. After recognizing the potential advantages of UWB, FCC developed a report to allow 

UWB as a communications and imaging technology. A UWB definition was created as a signal 

with a fractional bandwidth greater than 0.2 or which occupies more than 500 MHz of 

spectrum. The fractional bandwidth is defined as  

                                                      

2*(fH-fL) / (fH+fL) 

 

Where fH and fL are the upper and lower frequencies respectively measured at -10 dB below the 

peak emission point. To allow government and industry to conduct UWB testing, frequency 

spectrum from 3.1 GHz to 10.6 GHz was allocated for communications use below specified 

power levels while imaging was limited to below 960MHz as seen in Fig. 1.1 below. 

 

 

Fig. 1.1:  FCC Spectral Mask for UWB Indoor and outdoor Communication Systems 

 

Although the FCC has regulated spectrum and power levels for UWB, there is currently no 

standard for industry to follow. Discussions have developed on the use of two standards 

specifically, multiband orthogonal frequency division multiplexing (OFDM) and direct 

sequence spread spectrum (DS-SS) which is based on impulse radio technology.  

Each of these schemes OFDM and DS-SS has their advantages in a communications system 

although OFDM is currently a more popular technology. Impulse radio has many advantages 

over OFDM, with its ability to penetrate through materials and resolve multipath with path 

length differences on the order of a foot or less. Impulse radio also allows for lower power 

consumption with a low duty cycle, making it very beneficial in low probability of detection 

applications. Numerous multiple access techniques such as time-hopping and direct sequence 
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are commonly applied to impulse radio, giving it the ability to service many users in a network. 

There are three primary drawbacks to current implementations of impulse radio, namely lack of 

high data rates, lack of long communication range and analog components are necessary to 

construct the system. 

 

1.3 IMPORTANCE OF UWB ANTENNA AND PROJECT OVERVIEW 

 

Ultra Wide Band, a wireless communications technology that can currently transmit data at 

speeds between 40 to 60 Mbps and eventually up to 1 Gbps. UWB transmits ultra-low power 

radio signals with very short electrical pulses, often in the ps range, across all frequencies at 

once. UWB receivers must translate these short bursts of noise into data by listening for a 

familiar pulse sequence sent by the transmitter. 

Secondly, UWB systems operate at extremely low power transmission levels. By dividing the 

power of the signal across a huge frequency spectrum, the effect upon any frequency is below 

the acceptable noise floor. 

For example, 1 watt of power spread across 1 GHz of spectrum results in only 1 nano watt of 

power into each Hertz band of frequency. Thus, UWB signals do not cause significant 

interference to other wireless systems. 

 

 
Fig. 1.2: Ultra wideband communications spread transmitting energy across a wide spectrum of frequency. 

 

After the FCC approved for commercial use of ultra wideband in 2002, the feasible design and 

implementation of UWB system has become a highly competitive topic in both academy and 

industry communities of telecommunications. In particular, as a key component of the UWB 

system, an extremely broadband antenna will be launched in the frequency range from 3.1–10.6 

GHz, which has attracted significant research power in the recent years. Challenges of the 

feasible UWB antenna design include the UWB performances of the impedance matching and 
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radiation stability, the compact appearance of the antenna size and the low manufacturing cost 

for consumer electronics applications. 

It is noted that the UWB antenna design remains to be the main challenge in the progress of 

UWB technology. This is primarily attributed to the fact that antennas act as a band pass filter 

and limit the transmission bandwidth. It is claimed that, as a rule of thumb, antennas with a 

bandwidth such that the ratio of the maximum to minimum frequency is more than two are not 

easy to build practically. A UWB signal spanning the frequency range 1 GHz to 10 GHz has a 

ratio of 10 and therefore an antenna providing this bandwidth is very difficult to construct. 

From a compatibility point of view it would be useful to have information on the radiation 

patterns associated with UWB antennas. Little information on this was found in the references 

obtained, although the specific topic was not pursued in its own right. In many of the 

compatibility studies it is either assumed that the UWB devices radiate omni directionally or 

that their maximum radiated power is directed towards the receiver. 

Over the designated bandwidth of UWB system, there are some other existing narrowband 

services that already occupy frequencies in the UWB band, such as WLAN IEEE 802.11a and 

HIPERLAN/2 operating in the 5–6 GHz band. Besides the WLAN, in some Europe and Asia 

countries, WiMAX service from 3.3 to 3.6 GHz also operates in the UWB band. In some 

applications, UWB antenna uses filters to suppress dispensable bands. However, the uses of 

filters indeed increase the complexity of the UWB system and lead to increase in cost. It is 

desirable to design the UWB antenna with dual notched frequency bands both in 3.3–3.6 GHz 

and 5–6 GHz to minimize the potential interferences between UWB system and narrowband 

systems. 

 In this project a compact planar ultra wideband antenna with 3.4/5.5 GHz dual band-notched 

characteristics is investigated. The antenna consists of a beveled rectangular metal patch and a 

50 Ω CPW transmission line. By etching two nested C-shaped slots in the patch, band-rejected 

filtering properties in the WiMAX/WLAN bands has been achieved. The proposed antenna has 

been successfully designed and simulated. The simulated VSWR is in good agreement with the 

measured VSWR. The simulated result also shows stable radiation patterns and constant gain. 

 

 

 

 

 

 

 

 



5 

 

CHAPTER TWO 

 

ULTRA WIDE BAND TECHNOLOGY 

 

2.1 ULTRA WIDE BAND 

 

Wireless communication technology has changed our lives during the past two decades. In 

countless homes and offices, the cordless phones free us from the short leash of handset cords. 

Cell phones give us even more freedom such that we can communicate with each other at any 

time and in any place. Wireless local area network (WLAN) technology provides us easy 

access to the internet without suffering of unsightly and expensive cable. 

As we know UWB technology has been used in the areas of radar, sensing and military 

communications during the past 20 years. A substantial surge of research interest has occurred 

since February 2002, when the FCC issued a ruling that UWB could be used for data 

communications as well as for radar and safety applications. Since then, UWB technology has 

been rapidly advancing as a promising high data rate wireless communication technology for 

various applications. 

Ultra Wide Band is a radio technology based on the generation of very short Pulses of 

electromagnetic energy. These pulses, being short in the time domain, give rise to spectral 

components covering a very wide bandwidth in the frequency domain, hence the term Ultra 

Wide Band. It is claimed that the spectral components fall within existing regulations designed 

to control the unwanted emissions associated with conventional radio technologies and 

therefore should cause no problem to existing radio services. 

 

2.1.1 UWB Advantages 

 

Power Consumption 

The Federal Communications Commission power requirement for UWB systems is -

41.3dBm/MHz (75nW/MHz). Such a power restriction allows UWB systems to live below the 

noise floor of a typical narrowband receiver and enables UWB signals to coexist with current 

radio services with minimum interference. UWB radio offers short-range communication that 

uses 1/1000 of the power required for equivalent conventional transmission methods. Low 

battery power consumption is a constraint for many wireless communication systems, 
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especially in the transmission devices. Furthermore, since UWB signals use such low powers, 

they are less harmful to human. 

 

High Security 

Because of their low average transmission power, UWB communications systems have an 

inherent immunity to detection and interception. UWB pulses are time-modulated with codes 

unique to each transmitter and receiver. The time modulation of extremely narrow pulses will 

add security to UWB transmissions, because detecting Pico-second pulses without knowing 

when they will arrive is next to impossible. Such security is a critical need for military 

operations. 

 

Resistance to Interference 

Unlike the well-defined narrowband frequency spectrum, the UWB spectrum covers a vast 

range of frequencies. UWB signals then, are relatively resistant to intentional and unintentional 

jamming, because it is almost impossible to jam every frequency in the UWB spectrum at once. 

Thus, even though some of the frequencies are jammed, there will still be a range of 

frequencies that remain signal coding. UWB provides less interference than narrowband radio 

designs. Because of their low power spectrum density, unlicensed UWB radios will cause no 

interference to other radio systems operating in dedicated bands. 

 

High Performance in Multipath Channels 

The phenomenon known as multipath interference is unavoidable in many wireless 

communications channels. When signals are transmitted between transmitter and receiver, they 

scatter; reflect from objects and surfaces along the path. At the receiver end, the receiver sees 

the superposition of delayed versions of the original signal. When signals are continuous-waves 

or sinusoidal waveforms, these „replicas‟ may cancel the original signal due to the phase 

difference of the signals. UWB communication uses pulse waveforms and they tend not to 

overlap in time because of the extreme narrowness of the pulse. Because the transmission 

duration of a UWB pulse is shorter than a nanosecond in most cases, the reflected pulse has a 

small window of opportunity to collide with a line-of-sight (LOS) pulse and cause signal 

degradation.  

 

Strong Penetration Ability  

Unlike narrowband technologies, UWB systems can penetrate effectively through different 

materials. The low frequencies included in the broad range of the UWB frequency spectrum 

have long wavelengths, which allow UWB signals to penetrate a variety of materials, such as 
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walls. This property makes UWB technology viable for through-the-wall communications and 

ground penetrating radar. This is a great advantage for sealed space and body implant wireless 

communication.      

 

2.2 ANTENNA REQUIREMENTS AND SPESIFICATIONS FOR UWB 

APPLICATIONS 

 
To understand the challenges faced when designing antennas it is necessary to provide some 

background information on some of the key parameters and performance metrics. There are 

many antenna types with differing geometry but there are certain fundamental parameters that 

can be used to describe all of them. 

 

2.2.1Fundamental Antenna Parameters  

The most fundamental antenna parameters are: 

1. Impedance Bandwidth 

2. Radiation pattern 

3. Directivity 

4. Efficiency 

5. Gain 

6. Polarisation  

All of the parameters mentioned above are necessary to fully characterise an antenna, and to 

establish whether the antenna is optimised for its purpose.  

 

2.2.1.1Impedance Bandwidth  

The term „impedance bandwidth‟ is used to describe the bandwidth over which the antenna has 

acceptable losses due to mismatch. The impedance bandwidth can be measured by the 

characterisation of both the Voltage Standing Wave Ratio (VSWR) and Return Loss (RL) at the 

frequency band of interest. Both VSWR and RL are dependent on the reflection coefficient (Γ). 

Γ is defined as the ratio of the amplitude of the reflected voltage wave (V0 
-
) normalised to the 

amplitude of the incident voltage wave (V0 
+
) at a load. Γ can also be defined by using other 

field or circuit quantities and is defined by the following equation. 

Γ    =   V0
 – 

2.1
 

            V0 
+
  

VSWR =   ZL        OR        1+ Γ 2.2 
             Z 0                        1- Γ  

RL = -20 Log Γ 
2.3 
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The maximum acceptable mismatch for an antenna is normally 10% of the incident signal. For 

the reflection coefficient, this equates to Γ = 0.3162. For the impedance bandwidth 1< VSWR< 

2, and for Return Loss its value must be greater than 10 dB or S11 < -10 dB. 

 

2.2.1.2 Radiation pattern  

An antenna radiation pattern is defined in the IEEE Standard Definitions of Terms as: 

A mathematical function or a graphical representation of the radiation properties of the antenna 

as a function of space coordinates. In most cases, the radiation pattern is determined in the far-

field region and is represented as a function of the directional coordinates. Radiation properties 

include power flux density, radiation intensity, field strength, directivity, phase or polarisation. 

Primarily, when measuring the radiation pattern, the property of most interest is the energy 

radiated relative to the antennas position. This is usually measured using spherical coordinates. 

 

 

Fig. 2.1: Coordinate system, for antenna analysis 

 

The antenna under test is placed at the origin and is rotated through ɸ= 0° - 360° and θ = 0° - 

180° while the power is measured in the far-field. As shown in Fig. 2.1 the x-z plane is 
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considered the elevation plane. This is normally aligned with the electric field vector and is 

called the E-plane. The x-y plane is normally aligned with the magnetic field vector and is 

termed the H-plane.  

 

2.2.1.3 Directivity   

The ratio of the radiation intensity in a given direction from the antenna to the radiation 

intensity averaged over all the directions. The average radiation intensity is equal to the total 

power radiated by the antenna divided by 4π. If the direction is not specified, the direction of 

the maximum radiation intensity is implied. 

Essentially, this means that the directivity of an antenna is the ratio of the radiation intensity in 

a given direction over that of an isotropic source. This can be written as:  

 

                 

D = U/U0 2.4 

       = 4Πu/Prad 
2.5 

 

Where, 

  

U = radiation intensity (W/unit solid angle) 

U0 = radiation intensity of an isotropic source (W/unit solid angle) 

Prad = total radiated power (W)  

If the antenna is to radiate in all directions (isotropic radiator) then its directivity would be 

unity. As an isotropic radiator cannot be realised practically, the most comparable antenna is a 

short dipole, which has a directivity of 1.5. Any other antenna will have a higher directivity 

than 1.5, which means their patterns are more focused in a particular direction. 

 

2.2.1.4 Antenna Efficiency 

Like other microwave components, antennas can suffer from losses. The total antenna 

efficiency takes into account the losses at the input terminals, and within the structure of the 

antenna itself. 

The mismatch or reflection efficiency (ηr) is directly related to the return loss and can be 

defined as: 

 
ηr = 1-

|
Γ

|
 
2
                                                              2.6 

 
The radiation efficiency (η) is a measure of how much power is lost in the antenna due to 

conductor and dielectric losses. These losses reduce the radiation in any given direction and can 

be expressed as:  

               ɳ = Prad/Pin                                                                 2.7 
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2.2.1.5 Gain 

The ratio of the intensity in a given direction, to the radiation intensity that would be obtained if 

the power accepted by the antenna were radiated isotropically, the radiation intensity 

corresponding to the isotropically radiated power is equal to the power accepted by the antenna 

divided by 4π. This can be expressed as; 

 

                        G = 4πU (ɸ, Ө) /Pin                                                                        2.8

   

Unless specified, it is assumed that the antenna is receiving a signal in the direction of 

maximum gain. It is also common for the gain to be expressed in decibels and referenced to an 

isotropic source (G = 1), as shown; 

 

                           G (dBi) = 10 Log (G/1)                                              2.9 

 

2.2.1.6 Polarisation  

The property of an electromagnetic wave describing the time-varying direction and relative 

magnitude of the electric-field vector; specifically, the Fig. traced as a function of time by the 

extremity of the vector at a fixed location in space, and the sense in which it is traced, as 

observed along the direction of propagation.  

Polarisation is the curve traced by the tip of the electric field vector viewed in the direction of 

propagation. Fig. 2.2 shows a typical trace as a function of time. 

The polarisation of the wave may be linear, circular, or elliptical. The instantaneous electric 

field of a plane wave travelling in the negative z direction may be written as: 

 

 

                                            E (z, t) = E x (z, t) xˆ + E y (z, t) yˆ                                    2.10 
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Fig. 2.2: Rotation of a plane electromagnetic wave and its polarisation ellipse at z = 0 as a function of time. 
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The instantaneous components are related to their complex counterparts by: 

 

 
Ex (z, t) = Ey cos (ωt + βz + θx) 2.11 

and  

Ey (z, t) = Ex cos (ωt + βz + θy) 2.12 

 

 
Where Ex and Ey are the maximum magnitudes and θx and θy are the phase angles of the x and y 

components respectively, ω is the angular frequency and β is the propagation constant.  

 

2.3 COPLANAR WAVEGUIDE (CPW) TECHNOLOGY 

 

2.3.1 Introduction 

The CPW proposed by C. P. Wen in 1969 consisted of a dielectric substrate with conductors on 

the top surface. The conductors formed a centre strip separated by a narrow gap from two 

ground planes on either side. The dimensions of the centre strip, the gap, the thickness and 

permittivity of the dielectric substrate determined the effective dielectric constant, 

characteristic impedance and the attenuation of the line. This basic structure known as 

conventional CPW. 

A conventional CPW on a dielectric substrate consists of a centre strip conductor with semi-

infinite ground planes on either side as shown in Fig. 2.1. This structure supports a quasi-TEM 

mode of propagation. The CPW offers several advantages over conventional micro strip line: 

First, it simplifies fabrication: second, it facilitates easy shunt as well as series surface 

mounting of active and passive devices.  Third it eliminates the need for wrap around and via 

holes and fourth, it reduces radiation loss. Furthermore the characteristic impedance is 

determined by the ratio of a/b, so size reduction is possible without limit, the only penalty 

being higher losses. In addition a ground plane exists between any two adjacent lines; hence 

cross talk effects between adjacent lines are very week. As a result, CPW circuits can be made 

denser than conventional micro strip circuits. These, as well as several other advantages, make 

CPW ideally suited for MIC as well as MMIC applications. 

Major advantages gained in manufacturing are, first, CPW lends itself to the use of automatic 

pick-and-place and bond assembly equipments for surface mount component placement and 

interconnection of components respectively. 
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2.3.2 Performance of CPW 

The quasi-TEM mode of propagation on a CPW has low dispersion and hence it offers the 

potential to construct wide band circuits and components. In CPW amplifier circuits, by 

eliminating via holes and its associated parasitic source inductance, the gain can be enhanced. 

 

 

Fig. 2.3: Schematic of a coplanar waveguide (CPW) on a dielectric substrate of finite thickness. 

 

2.3.3 Types of CPW 

1- Conventional CPW 

2- Conductor backed CPW 

3- Micro machined CPW 

In a conventional CPW, the ground planes are of semi-infinite extent on either side. However, 

in a practical circuit the ground planes are made of finite extent. The conductor-backed CPW 

has an additional ground plane at the bottom surface of the substrate. This lower ground plane 

not only provides mechanical support to the substrate but also acts as a heat sink for circuits 

with active devices. A conductor backed CPW is shown in Fig. 2.2. The micro machined CPWs 

are of two types, namely, the micro shield line and the CPW suspended by a silicon dioxide 

membrane above a micro machined groove. 

These lines are illustrated in Figs. 2.3 and 2.4 respectively. The advantages of the micro shield 

line are its extremely wide bandwidth, minimal dispersion and zero dielectric loss. The 

advantage of the later CPW is that it is compatible with commercial CMOS foundry process 

and hence, is capable of monolithically integrating CMOS devices and circuits. 
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Fig. 2.4: Schematic of a conductor-backed coplanar waveguide (CBCPW). 

 

2.3.4 Typical Applications of CPW 

 

Micro-electromechanical Systems (MEMS) Metal Membrane Capacitive Switches 

The rapid progress made in the area of semiconductor wafer processing has led to the 

successful development of MEMS based microwave circuits. In a CPW the conductors are 

located on the top surface of a substrate which makes it ideally suited for fabricating metal 

membrane, capacitive, shunt-type switches. CPW MEMS shunt switches with good insertion 

loss characteristics, reasonable switching voltages, fast switching speed, and excellent linearity 

have recently been demonstrated. These switches offer the potential to build new generation of 

low-loss high-linearity microwave circuits for phased array antennas and communication 

systems. 

 

Thin Film High-Temperature Superconducting /Ferroelectric Tuneable Circuits 

and Components 

Recent advances made in the area of thin film deposition techniques, such as sputtering, 

chemical vapour deposition, and etching technologies, have resulted in the application of high 

temperature superconducting (HTS) materials to microwave circuits. The HTS circuits have 

low microwave surface resistance over a wide range of frequencies. As a result signal 

propagation takes place along these transmission lines with negligible amount of attenuation. 

Furthermore the advantage of using CPW is that only one surface of the substrate needs to be 

coated with HTS material before pattern. Recently HTS low-pass and band-stop CPW filters 

have been demonstrated. 

In addition by incorporating ferroelectric materials with HTS materials such as, low-loss, 

voltage-tuneable MMICs with reduced length scales can be constructed. These MMICs have 

potential applications in phased array antenna systems and frequency agile communications 
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systems. Recently voltage tuneable CPW phase shifters, mixers and filters have been 

demonstrated. 

 

Photonic Band gap Structures 

When an electromagnetic wave propagates along a conductor backed CPW some considerable 

amount of energy leakage takes place. The energy that leaks, propagates along the transverse 

directions away from the line, and excites a parallel plate mode between the CPW top and 

bottom ground planes. The parasitic parallel plate mode is the leading cause for crosstalk 

between adjacent circuits. The cross talk can be suppressed by constructing a photonic band 

gap lattice on the CPW top ground planes as demonstrated. 

 

Printed Antennas 

A radiating element is constructed from a conventional CPW by widening the centre strip 

conductor to form a rectangular or square patch. This patch produces a single-lobe, linearly 

polarized pattern directed normal to the plane of the conductors. The advantage gained over 

conventional micro strip patch antenna is lower cross polarized radiation from the feed. A 

conductor backed CPW with a series gap in the centre strip conductor is used to couple power 

to a patch through an aperture in the common ground plane. This design offers the flexibility of 

inserting semiconductor devices in the series gap of the feed for controlling the coupling 

The micro strip patch antennas have a lot of merits such as low-cost, low-profile, 

conformability, and ease of manufacture, which make them very attractive. The primary barrier 

to implementing these antennas in many applications, however, is their limited bandwidth only 

on the order of a few percent for a typical patch radiator. Because of this fact, much work has 

been devoted to increasing the bandwidth of micro strip patches. A straightforward method is 

to use a thick substrate with a low dielectric constant for the antenna. Another technique which 

can be implemented in the aperture coupled configuration is to use a near-resonance aperture in 

combination with the thick antennas substrate or multilayer substrates to achieve wide 

frequency band. But the common aperture coupled structure where the slot in the ground plane 

is fed via a micro strip line on an additional substrate layer which complicates the antenna 

design. Coplanar waveguides have been suggested as an alternate to micro strip-line for feeding 

the micro strip antenna and they have been used increasingly in the design of millimetre-wave 

micro strip antennas. 

However, there haven't been yet any special papers which systematically analyze feed 

characteristics of the coplanar waveguide with coupling slots. Although the coplanar 

waveguide with a C-shape slot has been studied in some papers, the effects of feeding structure 

dimensions on the antenna performance are not presented concretely. In this project, the 



16 

 

feeding performance of coplanar waveguides with dual-C and single C-shape are studied 

respectively. 

 

2.4 KEY REQUIREMENTS FOR UWB ANTENNAS  

 

The key requirements that should be considered are as follows:  

1. All of the parameters described above i.e. pattern, gain efficiency etc. must be 

considered when designing any type of antenna that is part of a RF-front end. However, 

UWB antennas have additional design challenges. For example, as the name suggests, 

the antenna must operate over a large bandwidth when compared to narrowband 

antennas. The bandwidth is specified by the FCC is 3.1 to 10.6 GHz; hence the antenna 

must achieve an impedance bandwidth of 7.5 GHz. 

 

2. Another important requirement is group delay. Group delay is defined as the rate of 

change of the total phase shift, θ, with respect to the angular frequency, ω, as shown in 

Equation 2.13. 

   

                                                        Group delay = d (Ө)/d (ω)                                          2.13 

 

If the phase is linear throughout the bandwidth then the group delay is constant 

throughout the bandwidth. Group delay can then be used as an indicator to show how 

well a pulse will be transmitted with consideration of distortion and dispersion. 

Normally, group delay is not considered in narrowband antenna design because linear 

phase is normally quite easy to achieve over a narrow band. Generally, if the group 

delay is in the tens of nano-seconds range, or less the performance is acceptable. 

 

3.  The radiation pattern is an extremely important requirement for UWB antennas. For 

wireless sensor network applications, it is desirable to have an Omni-directional pattern 

so orientation of the transmitter/receiver is not as important. As the antenna operates 

over a large bandwidth, its pattern at the low frequency cut-off (3.1 GHz) is different to 

that of the pattern at the higher frequency end (10.6 GHz), although good design can 

minimize this effect.  

 

4.  There are several other key requirements that are desirable for UWB antennas and are 

summarised below: 
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Compactness – Size is critical in terms of cost, as well as achieving the ultimate aim 

for this project. 

Planar – Ease of integration into monolithic circuits. 

 

Good VSWR (<2) – This is required across the whole band of operation so as to 

maintain good matching and efficient operation. 

Constant Gain – This is desirable across the whole band of operation because the signal 

is transmitted instantaneously across the whole (or a large part) of the frequency band 

(3.1 – 10.6 GHz).  
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CHAPTER THREE 

 

ANTENNA DESIGN 

 
 

3.1 DESIGNS OF UWB ANTENNAS  

 

For this project, we have four main parameters. Those parameters are the bandwidth, VSWR, 

gain, and the radiation pattern of the antenna. These parameters will help us understand if the 

antenna we are designing will be the optimal design for our application.  

As we know the several design methods and structures have been reported. These UWB 

antennas with filtering property at the 5–6 GHz band have been proposed not only to mitigate 

the potential interferences but also to remove the requirement of an extra band stop filter in the 

system [9]. 

Recently, more and more band-notched UWB antenna designs have been proposed. J.Kim 

proposed a 5.2 GHz notched UWB antenna using slot-type SRR [10]. This UWB antenna 

fulfils all the critical requirements including high radiation efficiency, low profile, stable 

radiation patterns and constant gain. However, the input impedance is not well matched at the 

lowest frequencies (3.1–3.8 GHz). In addition, the notched frequency band from 5–5.3 GHz 

cannot successfully block out the whole WLAN bands. The potential interferences between the 

UWB and WLAN systems cannot be reduced to the minimum. 

Yi-Cheng Lin have been discussed the design of three advanced band-notched 5–6 GHz UWB 

rectangular aperture antennas [8]. The antenna structure is simple and the aperture size is 

compact. Broad impedance bandwidth and stable radiation patterns are obtained, whereas the 

ground plane dimension is a bit large. In practice, when integrated with the system board of 

different ground plane size, the antenna might need a retuning for the optimized dimensions. 

Wang-Sang also has proposed wideband planar monopole antennas with dual band-notched 

characteristics [11]. This technique is suitable for creating UWB antenna with narrow 

frequency notches or for creating multiband antennas. However, the antenna is not suitable for 

integration with compact systems, because its ground plane is very large and it is perpendicular 

to the radiator, which limits its applications in compact UWB systems. Furthermore, the 

bandwidth performance of the antenna is from 2 GHz to 6 GHz, which can not satisfy the 

demands of UWB system. 

In [14] the authors propose a new ultra wide band antenna for UWB applications. The 

proposed antenna consists of a rectangular patch with two steps, a single slot on the 

patch and a partial ground plane but the gain is not constant. 
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3.2 CPW-FED UWB ANTENNA WITH DUAL BAND-NOTCH 

 

Based on the background of the researches above, a simple and compact CPW-fed planar UWB 

antenna with dual band-notched characteristics in 3.4 GHz (3.3–3.8 GHz) and 5.5 GHz (5–6 

GHz) is designed and tested. The dual band-notched operations are achieved by etching two 

nested C-shaped slots in the rectangular metal radiating patch. It is found that by adjusting the 

total length of the C-shaped slot to approximately half-wavelength of the desired notched 

frequency, a destructive interference can take place, causing the antenna nonresponsive at that 

frequency. It is easy to tune the notch centre frequency with the change in total length of slot. 

This antenna yields an impedance bandwidth of 3.1–10.6 GHz with VSWR≤2, except the 

WiMAX band (3.3–3.8 GHz) and (5–6) GHz for HIPERLAN/2 WLAN systems. The stable 

radiation patterns and constant gain are also obtained.  

 

The notch frequency is given by 

  

 

                                                    fnotch =C/(2L√ɛeff)                                                   3.1 

 

Besides WLAN systems, WiMAX also operates in the UWB band. To minimize the potential 

interferences between UWB system and narrowband systems, in this project, a kind of dual 

band-notched design is presented to demonstrate the superior features. By etching two nested 

C-shaped slots in radiating patch, the required dual band-notched filtering properties both in 

3.3–3.6 GHz band and 5–6 GHz band are achieved. 

  
3.2.1 Design 1 using trapezium ground plane   

 

Fig. 3.1 shows the geometry of the antenna without slot (antenna A1) which works in the 

frequency band (3.1-10.6GHz) of UWB without any frequency notch. 
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                  Fig. 3.1: Geometry and configuration of antenna without slot (antenna A1). 

 

The optimize dimensional of the antenna are 

T (Total length) =30mm W (Total width) =26mm 

T1 (Patch length) =14mm W1 (Patch width) =9mm 

T2=1.8mm W2 (slop) =1.5mm 

T3 (Fed width) =3.8mm W3 (Ground plane height) =9.2mm 

T4 (Gap) =0.5mm W4 (Ground plane height 2) =14.7mm 

 

 The antenna is fabricated on an h=1.6mm FR4 epoxy substrate with dielectric constant ɛr=4.4 

and loss tangent tan δ =0.02 and thickness h=1.6mm. As shown in the Fig. 3.1 a rectangle 

radiator is fed by a 50 CPW transmission line which is terminated with a sub miniature A 

(SMA) connector for measurement purpose. Since both the antenna and the feeding are 

implemented on the same plane, only one layer of substrate with single-sided metallization is 

used, and the manufacturing of the antenna is very easy and extremely low cost. Both the 

radiating patch and the ground plane are bevelled, which results in a smooth transition from one 

resonant mode to another and ensures good impedance match over a broad frequency range.   
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W= T= C/2*fL*√ɛreff 3.2 

  

ɛreff = (ɛr+1)/2  

  

T1= W1= C/2*fr*√ɛreff 3.3 

  

fr = (fH+fL)/2  

  

The width of the CPW-feed line is                                  

T3 ≤ 120*h*π/zo*√ɛr 3.4 

For good accuracy of CPW  

T4/h ≤ 0.5mm 3.5  

The ground plane size is  

W4 = C/2*fr*√ɛr 3.6 

 

To reduce the interferences from the IEEE802.11a and HIPERLAN/2 WLAN systems, the 

band-notched function is desirable in the UWB system. Fig.3.2 shows the geometry and 

dimensions of the UWB antenna with filtering property operating in the 5–6 GHz band 

(denoted as antenna A2). By etching a C-shaped slot in the rectangular radiating patch of 

antenna A1, a frequency band notch is created. Note that when the band-notched design applied 

to antenna A1, there is no retuning work required for the previously determined dimensions. 

 

 

Fig.3.2: Geometry and configuration of antenna with single slot (antenna A2). 
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Generally, the design concept of the notch function is to adjust the total length of the C-shaped 

slot to be approximately half-wavelength at the desired notched frequency, which makes the 

input impedance singular. The current distribution flows around the C-shaped slot. In this case, 

destructive interference for the excited surface currents in the antenna will occur, which causes 

the antenna to be nonresponsive at that frequency of 5.5 GHz. The impedance nearby the feed-

point changes acutely making large reflection at the desired notched frequency.  

The notch frequency given the dimensions of the band-notched feature can be postulated as  

 

 

L = slot length (19.2mm) 

Where 

LL1 = 6mm 

WW = 2.6mm 

LL = 8mm  

t = 0.5mm 

Besides WLAN systems, WiMAX also operates in the UWB band. To minimize the potential 

interferences between UWB system and narrowband systems in this project, a kind of dual 

band-notched design is presented to demonstrate the superior features. By etching two nested 

C-shaped slots in antenna 1, the required dual band-notched filtering properties are achieved.  

Fig. 3.3 shows the geometry of the dual band-notched UWB antenna (denoted as antenna A3) 

and the proposed C-shaped slots. The exterior C-shaped slot makes a notch band at 3.4 GHz 

and the interior C-shaped slot makes another one at 5.5 GHz, each of the total length of the C-

shaped slots is obtained by using equation 3.1. 

 

 

 

Fig. 3.3: Geometry and configuration of antenna with dual slot (antenna A3). 
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The length of the exterior C-shaped slot is 

L2 = 24.8mm 

t = 0.3mm 

Where„t‟ is the thickness of the slot. 

 

3.2.2 Design 2 using rectangular ground plane  

As the ground plane size is small, a few leakage currents distribute along the external conductor 

of the SMA connector and may affect the radiation patterns. To tackle this problem, an 

optimized ground plane dimension is needed. It is a very interesting work to discuss the 

relationship between ground plane and radiation patterns. 

So in this design we have done the optimization of design 1, in this case we replaced the 

trapezium ground plane in to rectangular ground plane (W3 = W4 = 14.7mm). 
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CHAPTER FOUR 

  

SIMULATION, FABRICATION AND MEASUREMENT  

 

4.1SIMULATION PROCESSES 

The simulation processes flow chart is given below in Fig 4.1.   

 

 

Fig.4.1: Flow chart of simulation processes  
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4.2 FABRICATION PROCESSES 

For fabrication process Circuit CAM software is used. Circuit CAM provides the user with a 

sophisticated CAM station. It can control all production data, modify the design step, repeat the 

complete layout, perform different design rule checks and generate ground planes. With the 

help of this software the DXF file can easily interface with the fabrication machine. The main 

procedures are:  

1-Importing of CAM files generated by PCB CAD systems 

2-Verification and design checks of the imported data 

3-Modifying the layout data for manufacturing purposes  

4-Tool paths generation for NC machines from LPKF  

5-Exporting of CAM files 

1-Export file ˃ auto CAD DXF file. 

2– Open circuit CAM ˃ file ˃ import 

Click ok. 

The below Fig.4.2 shows the antenna configuration fabrication setup. 
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Fig.4.2: fabrication setup 

The fabricated antenna shown in Fig.4.3.  

 

 

Fig.4.3: Photograph of fabricated antenna  

 

 

 

 

 

 



27 

 

4.3 MEASUREMENT  

The fabricated antenna was testing N5230 Network analyser. Fig.4.4 shows the measurement 

setup of antenna. 

 

Fig.4.4: measurement setup 

 

 

The VSWR measurement is shown in Fig. 4.5.  Ultra wide bandwidth from 3.1 GHz to 10.6 

GHz with two notch band is obtained. 

  

 

 

Fig.4.5: Measurement VSWR 
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CHAPTER FIVE 

 

RESULTS AND DISCUSSIONS 

   

5.1 ANTENNA A1 

 

Fig. 5.1 shows the simulated VSWR of antenna A1. It is found that the input impedance of the 

antenna A1 is well matched as the bandwidth covers the entire UWB band (3.1–10.6 GHz) and 

goes beyond the required 10.6 GHz with (VSWR ≤ 2). Fig. 5.2 presents the simulated gain for 

antenna A1. The antenna gain in the UWB band is about 2–5 dBi.  

 

 

Fig. 5.1: Simulated VSWR of antenna A1 with optimal dimensions.  

 

 

Group delay is another important requirement. Group delay is defined as the rate of change of 

the total phase shift θ, with respect to the angular frequency ω, as shown in Equation 5.1.   

 

    Group delay = d (Ө)/d (ω)                                                   5.1 
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Fig. 5.2: Simulated group delay of antenna A1 with optimal dimensions.  

 

If the phase is linear throughout the bandwidth then the group delay should be constant 

throughout the bandwidth. Group delay can then be used as an indicator to show how well a 

pulse will be transmitted without distortion and dispersion. Generally, if the group delay is in 

the tens of nano-seconds range or less the performance is acceptable. 

Fig. 5.2 shows the group delay vs frequency, the variation in group delay is 0.70 ns. The 

radiation intensity corresponding to the isotropic ally radiated power is equal to the power 

accepted by the antenna divided by 4π. This can be expressed as; 

 

G = 4πU(ɸ,Ө)/Pin 5.2 
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Fig. 5.3 presents the simulated gain for antenna A1. The antenna gain in the UWB band is 

about 3.5–6 dBi. The variation in gain in over all bandwidth is 2.5 dBi.   

 

 

 Fig. 5.3: Simulated gain of antenna A1.  

 

It is assumed that the antenna is receiving a signal in the direction of maximum gain. It 

is also common for the gain to be expressed in decibels and referenced to an isotropic 

source (G = 1), as shown; 

 

G (dBi) = 10 Log (G/1) 5.4 

 

5.2 ANTENNA A2 

By etching a C-shaped slot in the rectangular radiating patch of antenna A1, a frequency band 

notch is created. Generally speaking, the design concept of the notch function is to adjust the 

total length of the C-shaped slot to be approximately half-wavelength at the desired notched 

frequency, which makes the input impedance singular. For other frequencies, the addition of 

the C-shaped slot filter has few effects.  
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Fig. 5.4 (antenna A2) shows the single band notch 5.15-6.02 GHz using single slot. 

 

Fig. 5.4: Simulated VSWR of antenna A2 with optimal dimensions.  

In this case by using equation 2.2 and 5.1 the signal loss is 35% at 5.5 GHz, the antenna is not 

working or in other words we can say the liner phase response between input and output is not 

constant.  

 

 

 

Fig. 5.5: Simulated group delay of antenna A2 with optimal dimensions. 

 

Fig. 5.5 shows the group delay graph which shows that at 5.5 GHz, input and output are not in 

phase. 
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Fig. 5.6: Simulated gain of antenna A2.  

 

Fig. 5.6 presents the simulated gain for antenna A2. The antenna gain in the UWB band is 

about 3.5–6 dBi. The variation in gain in over all bandwidth is 2.5 dBi but at 5.5 GHz the gain 

is -3 dBi so at this frequency the loss will be occur. 
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(a)                                                                             (b) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(c) 

 

 

Fig. 5.7: Current distribution at (a) 3 GHz (b) 5.5 GHz (c) 8 GHz 

 

Fig. 5.7 shows the simulated current distributions at different frequencies. At 3 GHz and 8 

GHz, the current mainly flow along the feed line, while around the C-shaped slot the current is 

small. At 5.5 GHz the current mainly flows around the C-shaped slot. In this case, destructive 

interference (indicated by the oppositely phased vectors around the slot) for the excited surface 

currents in the antenna occurs, which causes the antenna to be nonresponsive at that frequency. 

The impedance near the feed-point changes acutely making large reflection at the desired 

notched frequency.  
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5.3 ANTENNA A3 

Two C- shaped slots were incorporated to achieve dual band notched characteristics. The 

interior notch length of 18mm at 3.4GHz and exterior notch of 26.5mm were cut to exhibit 

band notch design. 

5.3.1 Effect of geometrical parameters on antenna performance. 

Every geometrical parameter has different effects on the performance of the antenna. Four parts 

of CPW fed antenna is discussed. 

5.3.1.1 Effect of trapezium length W2 

Fig 5.8a shows the simulated VSWR of the antenna as a function of frequency for 3 different 

values of  W2 . Increasing W2 from 0.5mm to 2.5 mm increases the center frequency of notched 

band from 5.5 GHz to 6 GHz. It can be seen that the VSWR of center notch frequency varies 

from 5.2 to 4 for the lower band and 4.2 to 3 in the upper band.  From this result, one can 

conclude that the VSWR of the center frequency of the notch and filtering frequency is 

controllable by changing the width W2.  

5.3.1.2 Effect of bent patch angle Ө 

The effect of bent angle on the antenna performance is studied by varying Ө as in Fig5.8b. As 

Ө is increased from 14.5 ͦ   to 18.5 ͦ   VSWR varies from 4 to 3.2   in the lower band and from 4 

to 3.5 in the upper band, where as center frequency of the notch band remains almost fixed and 

VSWR bandwidth increased from   8 GHz to 10.6 GHz due to the electromagnetic coupling 

between the patch and the ground plane.  

5.3.1.3 Effect of Ground plane length W3 

Fig 5.8c indicates the simulated VSWR results of the antenna in terms of W3. For W3= 9.2, 

14.7 and 17mm with other dimensions fixed, the VSWR varies from 5.1 to 3.2 in the lower 

notch band and 6 to 4 in the upper notch band , with fixed center notch frequency.  

 

 

 

 

 

 

 

 

 

 

 

 

 

(a) 
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Fig. 5.8: Simulated VSWR of antenna A3 (a) variation of Θ (b) variation of w3 (c) variation of w2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5.9: Simulated VSWR of antenna A3 with optimal dimensions  

(b) 

(c) 
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Fig. 5.9, 5.10 and 5.11 shows VSWR, group delay and gain respectively of antenna A3 for 

optimal dimension. The group delay is almost constant throughout band width except 3.27-

3.82GHz and 5-5.82GHz notch frequency band and the variation in gain is 3 dBi only. 

 

 

 

Fig. 5.10: Simulated group delay (ns) of antenna A3 with optimal dimensions. 

 

  

 

 

Fig. 5.11: Simulated gain of antenna A3.  
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Since UWB system uses pulse transmission, an important issue is pulse distortion by the 

antenna. Ideally, a linear phase response (constant group delay) is desirable. Fig. 5.12 and Fig. 

5.13 show the simulated group delay and simulated gain of antenna A1, antenna A2 and 

antenna A3 respectively. The variation of the group delay of antenna A1 over the UWB band is 

less than 1 ns. The group delay variations of antenna A2 and antenna A3 highly exceed 4 ns in 

the vicinity of notch bands. However, in the un-notched frequency part, the group delay 

variations are small showing good characteristics. These group delay characteristics 

demonstrate that the proposed antennas exhibit phase linearity at desired UWB frequencies.  

 

 

 

Fig. 5.12: Simulated group delay (ns) of antenna A1, A2, A3 with optimal dimensions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5.13: Simulated gain dBi of antenna A1, A2, A3 with optimal dimensions. 
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Radiation pattern 

The simulated radiation patterns of antenna 3 in the E-plane (xz-plane) and H-plane (yz-plane) 

for three different frequencies 3, 8 and 10 GHz are shown in Fig. 5.14. The patterns in the H-

plane are quite omni directional as expected. In the E-plane, the radiation patterns remain 

roughly a dumbbell shape like a small dipole leading to bidirectional patterns.  

 

 

 3GHz 

       

                           

 
                             8 GHz                                                                            10GHz 

 
 

 

Fig. 5.14: Simulated radiation patterns of antenna A3 at 3, 8 & 10 GHz E-Field and H-Field 

 

 

It has been seen that this antenna A3 has nearly Omni-directional radiation pattern like normal 

monopole antennas. However, the Omni-directional radiation properties have a little 

deterioration as frequency increases. Over the entire bandwidth, it‟s similar to a conventional 

wideband monopole antenna. 
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                                                               (a) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                      (b)                                                                                            (c)  

 

 

Fig. 5.15: Shows the current distribution of antenna A3 at (a) at 3.5 GHz, (b) at 5.5 GHz, (c) 8 GHz 

 

5.4 Design 2 using rectangular ground plane  

It is noted that, as the ground plane size is small, a few leakage currents may distribute along 

the external conductor of the SMA connector and may affect the radiation patterns. To tackle 

this problem, an optimized ground plane dimension is needed.  Fig. 5.16 a, b, c shows the 

VSWR of antenna B1, B2 and B3.  
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(a) 

 

 

 

 

 

 

 

 

 

 

 

 

(b) 

 

 

 

 

 

 

 

 

 

 

 

 

(c) 

Fig. 5.16: Simulated VSWR of antenna B1 (a), B2 (b), B3(c) with optimal dimensions  
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Fig. 5.17 shows the compression between simulated and measured result of antenna B3. In 

entire BW of UWB the impedance is perfectly matched except notch band (3.3-3.8 and 5-

6GHz) but in measured case the notch band is slightly shifted to 0.3 GHz towards right due to 

the soldering problem.  

 

 

Fig. 5.17: Simulated and measured VSWR of antenna B3 with optimal dimensions  

Fig. 5.18 and 5.19 shows the group delay and gain of antenna B1, B2, B3. 

 

 

                

 

 

 

 

 

 

 

 

 

 

Fig. 5.18: Simulated group delay (ns) of antenna B3, B2, B3 with optimal dimensions. 
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Fig. 5.19: Simulated gain of antenna B1, B2, B3 with optimal dimensions. 
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CHAPTER SIX 

 

CONCLUSION AND FUTURE PROSPECTIVE 

 

CONCLUSION  

 

In wireless communications, ultra wideband has many advantages. This thesis introduces the 

design of UWB antenna to minimize the potential interferences between the UWB system and 

the narrowband systems, a compact CPW-fed planar UWB antenna with dual rejection bands at 

WiMAX /WLAN frequencies has been designed and discussed. The relationship between the 

total length of the C-shaped slot and the band-rejected operation has been given. Stable 

radiation patterns and constant gain in the UWB band are obtained. 

With regard to power consumptions, UWB wireless communication systems can provide better 

battery life for devices with less harm to the human body. This thesis has developed a method 

for improving the performance of transmitting antenna without potential interferences with the 

narrowband systems. By using this method, users can have better signal performance by better 

placing of the transmitting antenna. Users can easily design their devices for implantation, 

reducing cost and development time. 

The simulation results of the proposed antenna shows a good agreement in term of the VSWR, 

antenna gain and radiation patterns. Accordingly, this antenna is expected to be a good 

candidate in various UWB systems. 

 

FUTURE PROSPECTIVE 

 

Based on the conclusions drawn and the limitations of the work presented, future work can be 

carried out in the following areas:  

 

Firstly, it has been shown that UWB antennas operate in a hybrid mode of standing and 

travelling waves. A more detailed understanding of the travelling wave mechanism and the 

impedance variations could lead to improved design of UWB antennas. 

 

Secondly, in the future UWB systems, antenna might be embedded inside a laptop or other 

devices. Thus, the devices effects on the antenna performances to be investigated. When the 

antenna is built on a portable device, the impact from human body should also be considered. 
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Thirdly, UWB antenna with small size is always desirable for the WPAN applications, 

especially for mobile and portable devices. Future research may focus on finding out new 

methods to further reducing the sizes of UWB antennas. 

 

Fourthly, UWB systems operate at extremely low power level which limits its transmission 

range. In order to enhance the quality of the communication link and improve channel capacity 

and range, directional systems with high gain are required for some applications. Therefore, 

research on UWB directional antenna and antenna array could be carried out.  

 

Lastly, good time domain performance is a primary required for UWB antennas. Studies can be 

carried out to investigate the antenna effect on the transmitted signal and improve the time 

domain behaviours by optimizing the antenna configuration. 
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APPENDIX 

 

1 SIMULATION PROCESSES 

1.1 What is HFSS? 

HFSS is a high-performance full-wave electromagnetic (EM) field simulator for arbitrary 3D 

volumetric passive device modelling that takes advantage of the familiar Microsoft Windows 

graphical user interface. It integrates simulation, visualization, solid modelling, and automation 

in an easy-to-learn environment where solutions to your 3D EM problems are quickly and 

accurately obtained. Ansoft HFSS employs the Finite Element Method (FEM), adaptive 

meshing, and brilliant graphics to give you unparalleled performance and insight to all of your 

3D EM problems. Ansoft HFSS can be used to calculate parameters such as S Parameters, 

Resonant Frequency, and Fields. 

 

1.2 The HFSS Interface 

The main HFSS interface is shown in Figure 1, they are summarized as follows: 

1-3D Modeller Window - This is the area where you create the model geometry. This Window 

consists of the model view area (or grid) and the history tree as shown in Figure 1. The history 

tree documents the actions that have been taken in the model view area, and provides an 

alternative way to select objects in the model view area. 

2-Project Manager with Project Tree - The project manager window displays details about all 

open HFSS projects. Each project ultimately includes a geometric model, its boundary 

conditions and material assignments, and field solution and post processing information. An 

expanded view of the project manager is shown in Figure 1. 

3-Properties Window - The properties window consists of two tabs. The command tab displays 

information about an action selected in the history tree that was performed to either create an 

object or modify an object. The attribute tab displays information about the material and 

display properties of a selected object. 

4-Progress Window - This window is used when a simulation is running to monitor the 

solution's progress. 

5- Message Manager - This window displays messages associated with a project's development 

(such as error messages about the design's setup). 

 

 

1.3 Setting of HFSS 

Before you can use HFSS for the first time, there are a couple of items that need to be 

configured for efficient and accurate operation. 



47 

 

1. On the Tools menu, select Options => General Options ..., click the Default Units tab and 

ensure that Length is set to mm. Click OK. 

2. On the Tools menu, select Options => HFSS Options..., ensure the Include ferrite materials 

check box is checked. Click the Solver tab, set the number of Processors to 

4. Desired RAM Limit (MB) to 6000 and the Maximum RAM Limit (MB) to 8000. 

Click OK. 

 

 

Fig.1 Main screen of HFSS 

 

1.4 Ansoft HFSS flow-chart 

The Ansoft HFSS provides an intuitive, easy-to-use interface for developing passive RF device 

models. Creating designs, involves the following: 

1. Parametric Model Generation – creating the geometry, boundaries and excitations 

2. Analysis Setup – defining solution setup and frequency sweeps 

3. Results – creating 2D reports and field plots 

4. Solve Loop - the solution process is fully automated 

 

1.5 DESIGN PROCESSES 

Open HFSS and Save a New Project 

A project is a collection of one or more designs that is saved in a single *.hfss file. A new 

project is automatically created when HFSS is launched. Open HFSS and save the default 

project by a new name. 

1- Double-click the HFSS 10 icon on your desktop to launch HFSS. 
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A new project is listed in the project tree in the Project Manager window and is named Project 

by default. Project definitions, such as material assignments, are stored under the project name.  

 

 

2- On the File menu click Save As. 

3- Use the file browser to locate the folder in which you want to save the project, such as 

C:\Ansoft\HFSS10\Projects, and then double-click the folder‟s name. 

4- Type CPW feed in the File name text box, and then click Save. The project is saved in the 

folder you selected by the file name cpwfeed.hfss. 

 

Select a Solution Type 

Now you will specify the design‟s solution type. As you set up the design for analysis, 

available settings will depend upon the solution type. For this design, you will choose Driven 

Modal as the solution type, which is appropriate when calculating mode-based S-parameters of 

a passive, high-frequency waveguide that is being “driven” by a source. 

1- On the HFSS menu, click Solution Type. 

2- In the Solution Type dialog box, select Driven Modal, and then click 

OK. 

Set the Drawing Units 

You will now set the units of measurement for drawing the geometric model. 

1- On the 3D Modeller menu, click Units. 

2- In the Set Model Units dialog box, click in the Select units pulldown list, and then click 

OK. 
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Draw a Box 

Draw a 3D box object to represent the first section of the FR4 substrate. 

1- On the Draw menu, click Box. 

2- Specify the base corner of the box as (-13, -15, 0): 

a. Press Tab to move to the X text box in the status bar. 

b. Type 26 in the dX box, and then press Tab to move to the Y box. 

c. Type 30 in the dY box, and then press Tab. 

d. Type -1.6 in the dZ box, and then press Enter. 

The Properties window appears, with the Command tab selected, enabling you to modify the 

dimensions or position of the box. 
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While the Properties window is open, you will use it to assign a name (sub) to the box, 

confirm its material assignment, and make it more transparent. 

 

Draw the patch 

1. Click Draw>Line, or click the Draw line button on the toolbar. The status bar now prompts 

you to enter the first point of the polyline.  

2. Press the Tab key to move to the X box, and then select the first point of the line by entering 

the following values in the coordinate boxes, pressing Tab to move to the next coordinate text 

box:  

3. Press the Enter key to accept this point. You can delete the last point you entered by right-

clicking in the 3D Modeller window and then clicking back up on the shortcut menu.  

X coordinate 0  

Y coordinate 0  

Z coordinate 0 

4. Continue with this same method to enter the following 6 points that remain:  

              Point       X Coordinate          Y Coordinate       Z Coordinate  

                 1                -13                            -7                           0 

                 2                 -4                             -7                           0   

                 3                 -2.5                          -1.9                        0    

                 4                  13                           -1.9                        0  

                 5                  13                             0                          0  

                 6                 -13                             0                          0 

5- Right-click in the 3D Modeller window, and click Close Polyline on the shortcut menu. The 

2D polyline object appears in the drawing region.  

6- Assign the name ˃ patch. 
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Similarly we should draw ground plane and assign the name ˃gnd. 

 

 Mirror image 

1-select the patch and gnd ˃ right click ˃ edit ˃ duplicate ˃ mirror. 

x=0 y=0 z=0 

dx=0 dy=1 dz=0 

    

 

2-Unite- select the patch ˃ right click ˃ edit ˃ boolean ˃ unite. 

3- Press Ctrl+D to fit the object in the drawing region.  
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Boundary assignment 

Select the patch and gnd ˃ right click ˃ assign boundary ˃ finite conductivity  

. 

    

 

 

1-Select the Use Material check box, and click the material button (where the default vacuum 

is displayed). The Select Definition window appears. By default, this material browser lists all 

materials in the global material library, as well as the local material library for the current 

project, which is a subset of the global library.  

 

2- Select copper from the list of materials, and then click OK. The Finite Conductivity 

Boundary window reappears. The conductivity and permeability values for aluminum are now 

assigned to the finite conductivity boundary. 

 3- Clear Infinite Ground Plane if it is selected. If selected, the Infinite Ground Plane option 

simulates the effects of an infinite ground plane. This option only affects the calculation of 

near- and far-field radiation during post processing. The 3D Post Processor models the 

boundary as a finite portion of an infinite, perfectly - conducting plane.  

4- Click OK to accept the default name FiniteCond1 and apply the boundary  
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Mesh operation 

Select the patch and gnd ˃ HFSS ˃ mesh operation ˃ assign ˃ on selection ˃ length based. 

 

    

Then click ok. 

Assign Wave Port 1  

1- Deselect the perfect E boundary you just assigned, if it is still selected. 

2- In Select Faces mode, select the face of port 1. 

3- On the HFSS menu, click Excitations>Assign>Wave Port. The Wave Port wizard 

appears.  

4- In the Wave Port: General step, accept the default name WavePort1, and then click next.  

5- In the Wave Port: Modes step, accept the default settings, and then click next. 

6- In the Wave Port: Post Processing step, accept the default settings, and then click Finish to 

complete the wave port assignment for port 1. WavePort1 is assigned to the waveguide and 

now appears as a subentry of Excitations in the. 
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Draw the radiation box 

Select vacuum ˃ click box 

X=-13, y=-15, z=-6, dx=26, dy=30, dz=-12 ˃ enter. 

 

Click ok. 

Right click on the box ˃ assign boundary ˃ radiation ˃ ok. 
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HFSS ˃ radiation ˃ far field setup ˃ infinite sphere. 

 

 

Click ok. 

 

 Analysis setup 

Perform the following steps to set up the analysis options: 

1- Right click on Analysis in the Project Tree, and select ˃Add Solution Setup" 

2- Under the General tab: 

(a) Set the solution frequency to 6.86 GHz 

(b) Set the maximum number of passes to 6 

(c) Set maximum Delta S to 0.02 

3- Under the Options tab: 

(a) Set the Maximum Refinement per pass to 20%. 

(b) Set the Order of Basis Functions to Second Order 

Perform the following steps to set up the frequency sweep: 
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1- Under the Analysis item in the Project Tree, right-click on Setup1 

2- Select Add Frequency Sweep... 

3- Set start frequency to 3 GHz 

4- Set stop frequency to 11 GHz 

5- Set step size to 0.02 GHz 

6- Click OK. 

Result 

HFSS ˃ result ˃ create report 

    

Click ok ˃ vswr ˃ add trace ˃ done. 

 

4- FABRICATION PROCESSES 

In fabrication processes we have used circuit CAM software. 

1 – HFSS ˃ 3D modular ˃ export ˃ auto CAD DXF file. 

 

2– Open circuit CAM ˃ file ˃ import 
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Click ok. 

 

The above windows show the layout of the antenna so we should fill the copper where we 

need. So after filling the copper the file will be as shown below.  
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With the help of this file the software (circuit CAM) can interface easily with the machine. 

 

 

  

 

   

 


